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CHAPTER 1 

BEFORE USING YOUR UML397 Wireless Modem 
ABOUT THIS USER MANUAL 

PRODUCT OVERVIEW 

WHAT’S INSIDE THE PRODUCT PACKAGE 

INTRODUCTION TO WIRELESS UML395 USB MODEM 

PRODUCT FEATURES 

PRODUCT HANDLING 

CONFIGURATION 

ABOUT THIS USER MANUAL 

■ ABOUT THIS USER MANUAL 

You will find all the information you need to install and use the UML397 4G LTE Wireless Modem in this user manual. Before using the 

Wireless Modem, you must properly install the U.S. Cellular® Broadband Connect by closely following the installation instructions. 

INSTRUCTIONS 

• The U.S. Cellular Broadband Connect dialer software is preloaded on the device. 

• It is highly recommended that you read the safety precautions described in this manual before using the Wireless Modem. 

This User Guide is described for Windows-based users. User interfaces may be slightly different for Macintosh. 

■ WHAT’S INSIDE THE PRODUCT PACKAGE 

The following items are included in the product package. If any of the items listed below are missing, please contact the retail location where you 
purchased the product. 

• UML397 4G LTE Wireless Modem 

• 4G LTE SIM Card 

• Quick Start Guide 

■ PRODUCT OVERVIEW  

Thank you for your purchase. The UML397 4G LTE Wireless Modem is a 4G LTE wireless device that enables high-speed wireless 

communication from your laptop or desktop computer. The UML397 4G LTE Wireless Modem is simple to install and use. 

 

The Wireless Modem is designed for your laptop or desktop computer’s USB port, which is available in most models. The Wireless Modem can 

be used to access the Internet, your company’s intranet, or you can use it to send and receive email. It is extremely useful when you are away 

from the office, on the road, or wherever a wired Internet access is not readily available. 

 

The following figure shows the appearance of the Wireless Modem. It is provided only for your reference. The figure on the right 

shows a product with its cover removed. The actual product may be different. 

 

 

 

 Rotatable USB Connector 

It connects the Wireless Modem to a PC. 
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 RF Output Power Port 

It connects an RF cable to the Wireless Modem for RF tests. 

 Indicator 

It indicates the status of the Wireless Modem. 

 Green, blinking twice every 2s: The Wireless Modem is powered on. 

 Green, blinking once every 0.2s: The U.S. Cellular® Broadband Connect of the Wireless Modem is being upgraded. 

 Green, blinking once every 2s: The Wireless Modem is registering with a 1X network. 
 Blue, blinking once every 2s: The Wireless Modem is registering with a 3G network. 

 Cyan, blinking once every 2s: The Wireless Modem is registering with a 4G LTE network. 

 Green, solid: The Wireless Modem is connected to a 1X network. 
 Blue, solid: The Wireless Modem is connected to a 3G network. 

 Cyan, solid: The Wireless Modem is connected to a 4G LTE network. 
 Off: The Wireless Modem is removed. 

 SIM Card Slot 

It holds a Subscriber Identity Module (SIM) card. 

 Button 

Press the button to turn over the USB connector, as shown in the following figure. 

 

 

 microSD Card Slot 

It holds a microSD card.  

 

Getting Started 

Installing the SIM Card 

1.  Slide the front cover off. 

2.  Insert the SIM card into the card slot.  

3.  Slide the front cover back onto the Wireless Modem until it snaps into place. 
 

 

Inserting the microSD Card 

Insert the microSD card into the Wireless Modem, as shown in the following figure. 
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Note:  

 The microSD card is an optional accessory. If it is not provided in the package, you can buy one yourself. 

 Ensure that the beveled edge of the SIM card is properly aligned with that of the SIM card slot and the microSD card is inserted according to 
the direction as labeled on the microSD card slot. 

 Do not remove the microSD or SIM card when the card is in use. Otherwise, the card as well as your Wireless Modem may get damaged and 

the data stored on the card may be corrupted. 
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CHAPTER 2 

INSTALLING UML397 4G LTE Wireless Modem   
PRECAUTIONS 

RECOMMENDED SYSTEM REQUIREMENTS 

INSTALLING U.S. Cellular® Broadband Connect 

PRECAUTIONS 

■ PRECAUTIONS  

• Once the modem has been inserted into the laptop or desktop computer, do not remove it without first completing the unplugging/ejection 

process.  

■ RECOMMENDED SYSTEM REQUIREMENTS 

U.S. Cellular Broadband Connect operates in Windows® XP, Vista, 7 or Mac environments. 

Check the following points in order to ensure the application works correctly: 

• Minimum screen resolution recommended: 800x600 256 colors. 

• 130MB or more of available hard disk space for PC and 15MB available hard disk space for Mac. 

WINDOWS XP SERVICE PACK 2 OR HIGHER 
• Minimum 300 MHz Processor. 

• 512 MB of RAM recommended. 

• Service Pack 2. 

WINDOWS VISTA SERVICE PACK 1 OR HIGHER  
• PC featuring a Pentium® IV 2 GHz or better processor. 

• 512 MB of RAM recommended. 

WINDOWS 7 
• PC featuring a Pentium IV 2 GHz or better processor. 

• 512 MB of RAM recommended. 

MAC OS X 10.5, 10.6, 10.7 

 

■ INSTALLING U.S. Cellular® Broadband Connect   

INSTALLATION  

• If you install U.S. Cellular Broadband Connect, it will install the USB Driver for the UML397 4G LTE Modem. Follow the instructions from 
the U.S. Cellular Broadband Connect for installation. 

WARNINGS! 

• Make sure to complete the unplugging/ejection process BEFORE removing the UML397 Wireless Modem. If you remove the device 
improperly, the product may be damaged. 

• If you have inserted the device properly, Windows will inform you of the new hardware. Wait until Windows completes the “Found New Hardware” task. In 

Windows XP, several tool tips similar to the “Found New Hardware” function will appear and disappear in the system tray automatically. In Windows Vista, several 

tool tips similar to the “Installing device driver software” function will appear and disappear in the system tray automatically. Once hardware detection is complete, 

you will be prompted to start activation. 

•For Mac OS, a device icon will appear on the desktop. Before unplugging the USB modem, be sure to move the icon to the trash for proper ejection. 

 

• It is normal to hear a short beep sound each time you insert or remove the UML397 Wireless Modem. It is an audible notification that your laptop or desktop 

computer recognizes the new hardware. 
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• When removing the UML397 Wireless Modem always grip the top and bottom of the modem and push/pull carefully.  
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CHAPTER 3 

SETUP 
THE U.S. CELLULAR® BROADBAND CONNECT SETUP PROGRAM (WIN) 

THE U.S. CELLULAR BROADBAND CONNECT SETUP PROGRAM (MAC) 

GETTING STARTED 

This chapter will guide you through the setup process for U.S. Cellular Broadband Connect. Before getting started, you should become familiar 

with the documentation that came with your wireless device. 

GETTING STARTED (WINDOWS) 

Follow these steps to install U.S. Cellular Broadband Connect: 

1 Turn on your computer and close all applications. 

2 Insert the UML397 Wireless Modem into the USB port. 

3 If set up does not automatically start: 

 a. Click the Start Button. 

 b. Choose My Computer. 

 c. Find and double click on the drive icon (U.S. Cellular Broadband Connect) that represents the Wireless Modem. 

4 Follow the steps in the next section. 

 
STEP 1: To install on your hard drive, connect your device to your PC. The installation process will start automatically.  

Select the language for the installation from the choices below – “English” or “Spanish” and click the “Next” button. 
 

 
 
STEP 2: In the “U.S. Cellular Broadband Connect – License Agreement” screen, you will see the Program User License Agreement. In order to 

install and use this product, you must agree with the terms of this agreement. Select “I agree” then click the “Next” button to continue. If you do 

not agree with this agreement, click the “Cancel” button to exit. 

 

 
 
STEP 3: After agreeing to the License Agreement, you will see the “U.S. Cellular® Broadband Connect – Setup Type” screen. You can select 

from the two setup types – Express Install or Custom Install. It is recommended that you choose Express Install. Click the “Next” button to 

continue.   
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STEP 4: During this step, the components of U.S. Cellular Broadband Connect are being installed onto your computer. 

 

 
 
STEP 5: “The Install Shield Wizard has successfully installed U.S. Cellular Broadband Connect” appears on the screen. Click “Finish” button. 

 

 
 

STEP 6: The setup program will create an Access shortcut and the U.S. Cellular Broadband Connect will launch automatically. Now the 

installation is complete. 
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GETTING STARTED (MAC) 

Follow these steps to install U.S. Cellular Broadband Connect: 

1 Turn on your computer and close all applications. 

2 Insert the UML397 Wireless Modem into the USB port. 

3 Find and double click on the drive icon that represents the Wireless Modem. 

4 Find and run the U.S. Cellular Broadband Connect icon in the MAC U.S. Cellular Broadband Connect folder. 

5 Double click the U.S. Cellular Broadband Connect icon to begin the installation. 

6 Follow the steps in the next section. 

 

■ THE U.S. CELLULAR® BROADBAND CONNECT SETUP PROGRAM (MAC) 

STEP 1:  Double click the U.S. Cellular® Broadband Connect setup program. 

 
When the pop-up screen appears to confirm installing the U.S. Cellular Broadband Connect, click the “Continue” button to continue with the 
installation process. 

 
 

STEP 2: The “Welcome” screen appears. Click the “Continue” button.  

 

 
 
STEP 3: The “Info & Manual” screen appears. Click the “Continue” button 

 

 
 
STEP 4: You are now ready to select the location on your computer where U.S. Cellular Broadband Connect should be installed. 
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STEP 5:  During this step the components of U.S. Cellular Broadband Connect are being installed onto your computer. Installation will occur to 

the destination folder specified in Step 4 above or you may change the installation location by pressing 
 

   
 

“Change Installation Location...” 

 
 
STEP 6: Installing the U.S. Cellular® Broadband Connect requires you to restart your computer when the installation is complete. Please check 

that no other programs are running, and then press “Continue Installation”. 

 

 
 
STEP 7: While your computer is running the installer script, do not turn your computer off. 

 
 
STEP 8: Select U.S Cellular Broadband Connect start-up option and click the “Continue” button. 
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STEP 9: Installation is now complete. Click the “Restart” button to leave the U.S. Cellular Broadband Connect setup program and restart your 

computer. 

 

 
To view the Guide go to Help > U.S. Cellular Broadband Connect Help. 
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CHAPTER 4 

USING U.S. CELLULAR
®
 BROADBAND CONNECT 

FEATURES 

GETTING STARTED 

CONNECTING 

ADDITIONAL FEATURES 

THE FILE MENU 

THE VIEW MENU 

THE TOOLS MENU 

THE OPTIONS MENU 

THE HELP MENU 

FEATURES 

Today’s online world offers more services every day and U.S. Cellular® gives you the tools you need to take advantage of the best in 
connectivity solutions. With U.S. Cellular Broadband Connect, enjoy the freedom and convenience of wireless Internet connectivity from your 

computer! 

■ FEATURES 

WWAN (WIRELESS WIDE AREA NETWORK, 1x/3G/4G LTE) SPECIFIC FEATURES 

• Creates a U.S. Cellular Wireless Internet connection. 

• Displays signal strength for your Wireless Modem. 

OTHER FEATURES 

• Can launch your browser, VPN or a program of your choice upon connection. 

• Logs connections used, duration and bytes sent and received. 

• See the section “Additional Features” for more information about the features of U.S. Cellular Broadband Connect. 

■ GETTING STARTED 

Double click on the U.S. Cellular Broadband Connect icon on your desktop or click on the Windows Start menu and select U.S. Cellular 

Broadband Connect from the list of Programs. 

    
     PC                             MAC 

ABOUT THE USER INTERFACE 

The U.S. Cellular Broadband Connect will launch the main user interface. This is where you manage your Broadband Connection. At a glance 

you can see the signal strength. Your current connection state, the elapsed time of the connection, total data used during the connection, as well as 

total network data used are displayed. 
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■ CONNECTING 

U.S. Cellular® Broadband Connect allows users to connect to the data network by clicking one button on the main User Interface. This can 

also be accessed by selecting the File > Connect to Internet. 

To help ensure users data usage stays within their data plans, there is an option in the application to set U.S. Cellular Broadband Connect to 

disconnect the Internet connection after a specific amount of time or after a specific amount of data has been exchanged. 

When creating the Internet connection, U.S. Cellular Broadband Connect must get the phone number from the device and include it as the 

username when needed. The Data Connection is accessed using Network Driver Interface Specification (NDIS). 

Once your device is properly configured, connecting to the Internet is as simple as clicking the Connect/Disconnect Button. 

Simply click this to end your current connection. 

 
 

THE STATUS BAR 
Information regarding your current network connection can be seen in the status bar along in the middle of the U.S. Cellular Broadband Connect 

interface. For more information on this status bar, see the section “The Status Bar” in the “Additional Features” section. 

At any time during your connection you can check your current connection speed and throughput stats in the Statistics tab of the Session 

Information window. To see this window, select “Statistics” from the “View” menu. 

The Connection Monitor window displays information about your data connection. 

The Statistics section provides real time data throughput for current data connection. The Received tab provides received real time throughput.  
The transmitted tab provides transmitted real time throughput. 

The status section indicates the status, the duration and the speed of your connection. This information is required to be the same as the 
information displayed on the main screen. 

The Internet Protocol (TCP/IP) button displays the 
 

 
 

Internet Protocol (TCP/IP) windows shows the Internet Protocol properties. 

 

USING THE “DATA” CONNECTION 

By default U.S. Cellular Broadband enables the U.S. Cellular Broadband Connect for data connections. If your connection fails 

when you try to connect, please try to reconnect. 

DORMANCY: 

The data session becomes dormant if you are not sending or receiving any data. As soon as you resume sending or receiving data, the data session 
will return to an active state. 
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■ ADDITIONAL FEATURES 

In addition to the basic features mentioned in previous sections, U.S. Cellular® Broadband Connect has the additional features listed below. 

CONNECTION STATUS 

The text on the connect/disconnect button indicates your current state. During an active connection, this text will change to “Disconnect”. If you 

are not connected, it will display “Connect”. 

WWAN (WIRELESS WIDE AREA NETWORK, 1x/3G/4G LTE) STATUS AREA 

The text can change to the following: 

• Device not connected: Your Wireless Modem is removed from the laptop. 

• Device not activated: Your Wireless Modem needs to be activated.  If your device is not activated please retry activating your device by 

disconnecting and then re-connecting your Wireless Modem or please contact U.S. Cellular® Customer Service at 1-888-944-9400 or dial 611 

from your U.S. Cellular wireless phone.  

AVAILABLE NETWORK CONNECTIONS 

• If the Wi-Fi Icon is illuminated your PC currently has a network connection over Wi-Fi 

• If the Ethernet Icon is illuminated your PC currently has a network connection over Ethernet. 
•If an Ethernet or Wi-Fi connection becomes available while connected your cellular data connection will be disabled in favor of the Ethernet or 

Wi-Fi connection. 

QUICK LAUNCH ICONS 

• Browser – Launch default Internet browser. 

• My Account – Launch default Internet browser to your Login page at uscellular.com. 

• Text Message Envelope – Launch Text Inbox. 

■ THE FILE MENU 

 

   
 

CONNECT TO INTERNET / DISCONNECT FROM INTERNET 

Allows you to connect or disconnect your Internet connection. 

EXIT 

Exit the application. 

■ THE VIEW MENU 

STATISTICS 

The main statistics screen shows you information about your data connection.  The data displayed is the Network Speed, Connection Duration, 
and the Bytes sent and received. This information is obtained by monitoring the U.S. Cellular Broadband connection created in Windows. 

DATA CONNECTION LOG 

U.S. Cellular Broadband Connect contains a log file of all connection made using the application. The data in the log can be easily sorted by 

connection, number, date/time, duration, bytes sent, bytes received, total bytes and status. The data will be taken from the device and then deleted 

on the device and stored on the PC. This ensures if the user connects outside of the U.S. Cellular Broadband Connect it is still recorded into the 

log file. 

The data that are recorded and stored in the log file are Numbered Dialed, Call Duration, Bytes Sent, Bytes Received, Total Bytes, Date/Time of 

call, Disconnect Errors (Errors recorded are the Windows errors received when making the connection). 
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TEXT MSG 
U.S. Cellular® Broadband Connect enables you to receive text messages. The Inbox displays the received messages. Check for Messages will 
search the device for received messages. If there are unread messages, the unread messages are listed in bold and shown in the Inbox. For 

Windows users, the system tray also shows the green message icon which indicates there are unread messages in your inbox. The green message 

icon and the bold listings disappear as soon as you have read the message. 

 

   
 
• Click File -> Open to view the message, or you can simply double click the messages listed in the Inbox. 

• Messages are sorted by Contact, Date/Time, Type, Status, Character length, Subject, or Callback number. 

• Right click the messages to save as a text file.  

• You can print, change the status, or delete the messages. 

Text Message function supports receiving text messages while your device is connected to the internet. Sending the text message is not available by using the Text 

Message function. 

■ THE TOOLS MENU 

 

GENERAL SETUP 

General Setup allows users to make changes to the U.S. Cellular Broadband Connect. This section is split into multiple parts. 

INTERNET CONNECTION TAB 

This option allows users to change the Internet options.  Here you can set U.S. Cellular Broadband Connect to disconnect after a specific amount 

of time or data. You can also set U.S. Cellular Broadband Connect to automatically retry the connection when the application starts but the 
connection fails. In the past the option to connect after the connection fails was dependent on starting the connection when the application starts. 

This needs to be changed to be two separate options. 
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In the When Connected section, select “Open Web Browser” and/or “Go To URL”. You can specify the URL to visit when the connection 
succeeds.  

To set up automatic disconnect parameters based on data or time elapsed, go to the Launch Internet Connection section, click the “Manually”, 
“Automatically when application starts”, or “Automatically when application starts except when roaming” button and follow these steps: 
1 Check the box. 

2 Then click the corresponding radio button to define specific amount of time or data. 

3 Use the scrolling list to select amount of minutes or Mb. 

In the Network Connection section, you can connect to only a 1x/3G data network or CDMA Home network only over NDIS. Check the box to 

use only 3G data networks or CDMA Home only. 
Move to another tab if necessary or click the OK button to confirm your choice. You can also set to connect automatically when the application 

starts and if the connection fails.  
 

TEXT ALERTS TAB 

This section displays the text alerts features.  

 

 

 
Default: Uses the U.S. Cellular® Broadband Connects default sounds notification.  

File: Allow you to select a .wav file to be used as the sound notification. 

 

MISCELLANEOUS TAB 

This section displays the startup features.  Here you can select to start U.S. Cellular Broadband Connect on computer start-up and start with the 

ability to start the application minimized. 
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Launch U.S. Cellular® Broadband Connect at Startup: Automatically launches U.S. Cellular Broadband Connect whenever you start your 

computer. 

Start minimized: When you minimize the application it will now show in the task bar. To restore the application, click on the U.S. Cellular 

Broadband Connect tray icon. 

Automatically run U.S. Cellular Broadband Connect when device is inserted: Automatically launches U.S. Cellular Broadband Connect 

when the UML397 Wireless Modem is connected to your PC or laptop. 
Show Data Usage Details when application starts: Automatically launches the Data Connection logs window when U.S. Cellular 

Broadband Connect starts. 
Ask before terminating data connection: Will prompt the user to confirm they would like to disconnect there data connection before 

connection is terminated. 
 

 

VPN CLIENT 

When the U.S. Cellular Broadband Connect connects to the data network, VPN setup wizard allows you to configure the VPN settings. 
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You may choose Microsoft VPN, or other provider listed on the “Use another client VPN”. Selecting Other will allow you to set your own VPN 

EXE and parameters. 

The option to enable and disable this feature needs to be in the IT Manager tool as well as the ability for the manager to setup the VPN parameters. 

 
Control Panel 
The control panels are accessed through the menu of U.S. Cellular® Broadband Connect. This section allows users to open new windows for 

details on their device and about their computer. 

Modem will open the computer phone and modem details. 

Network and Dial-Up Connection will open computer Network Connection Page.  

Internet will open the Windows Internet Properties page. 

All will open the computer Control Panel. 

■ THE OPTIONS MENU 

3G Only Mode 

U.S. Cellular Broadband Connect provides the user an option to only connect to 1x/3G data network. This status will display 3G only on the main 

User Interface under the network type.  To activate this feature go to Options > 3G Only Mode. 

CDMA Home Only  

Connection Manager provides the user an option for the device to only camp on 1x/EvDO Home network. This will ensure that your device only 

Connects to the U.S. Cellular CDMA network. 

Dial *228 

*228 is a function that is seldom needed and is used for U.S. Cellular internal processes. Please do not use this function unless instructed by a 

U.S. Cellular Associate.  If you have questions or concerns please reach out to U.S. Cellular Customer Service. 

POWER ON/OFF DEVICE 

This is used to power the on/off Wireless Modem. 

■ THE HELP MENU 
The U.S. Cellular Broadband Connect has a Help section. Please see the Help section for additional information.  

 
 

  

 

LIVE UPDATE 

The U.S. Cellular Broadband Connect offers a live update wizard that allows the application to be kept up to date.  The Live Update wizard is a 

separate application that is integrated into U.S. Cellular Broadband Connect.  The application searches on the Internet for new updates based on 
version numbers and will download and install the update.  This application can be run manually or automatically and is launched from the Start 

menu. 
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GUIDE 

Shortcut to the user guide. 

HELP TOPICS 

Launches this help file. 

ABOUT DEVICE 

About device will have the following Information. 



21 
 

  
ABOUT U.S. CELLULAR® BROADBAND CONNECT 

 
 
 
 


